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1 Minimum System Requirements 
 
To install the tour guide application, you must have: 
 

• A Dell Axim X30 PocketPC 
• The PocketPC 2003 Platform (installed by 

default on Dell PocketPCs) 
• The Ekahau client application installed on the 

PocketPC 
• A PC with a CD or DVD drive and Microsoft 

ActiveSync installed 
• At least 5 MB of free disk space on the 

PocketPC for the tour guide application 
 
Typical users will check out a properly configured 
PocketPC from the EECS building and can ignore the 
installation instructions provided below.  These 
instructions are of an advanced nature and have been 
provided for tour administrators who are configuring 
new PocketPCs to run the tour guide application or 
advanced users that wish to modify tour content. 

2 Installation Instructions 
 
The tour guide application was designed to run on the 
PocketPC 2003 platform.  Some steps must be taken 
prior to launching the setup application on a 
PocketPC: 
 

• Microsoft ActiveSync must be installed on 
your PC.  If ActiveSync is running, the 
ActiveSync icon appears on the Windows 
taskbar.  ActiveSync is used to synchronize 
communication between your PC and 
PocketPC.  You can download the newest 
version from Microsoft at 
<http://www.microsoft.com/windowsmobile> 

• The Ekahau client must be installed on your 
PocketPC.  Ekahau is the location sensing 
system that has been installed in the EECS 
building, and the client application is used to 
communicate with Ekahau.  The client must 
be installed prior to the launch of the tour 
guide application.  If Ekahau is running on 
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your PocketPC, a “blue bubble” icon will 
appear near the bottom right of your screen. 
Detailed installation instructions can be found 
in section 2.2, or can be accessed using a web 
browser on the wherefid project home page, 
found at 
<http://www.eecs.umich.edu/~wherefid/ekaha
u/ekahau-ppc.html>. 

 
Installation steps have been detailed in sections 2.1-
2.5. 

2.1 Installation of Microsoft ActiveSync 
 
If you have never connected your PocketPC to a 
computer, Microsoft ActiveSync may not be installed.  
To install ActiveSync: 
 
1.  Download the latest version of ActiveSync 
(MSASYNC.EXE) onto your PC from Microsoft’s 
website. 
2.  Run MSASYNC.EXE and follow the on-screen 
instructions. 
3.  Verify that your PocketPC is recognized by 
connecting it to your PC.   
4.  When prompted to choose a partnership type, select 
“Guest” and hit the Next button. 
5.  ActiveSync will verify connectivity by displaying 
“Connected” near the top of the window.  Setup is 
complete. 

2.2 Installation of Ekahau Client 
 
To set up Ekahau on your PocketPC:  

1. Write down your MAC address. Ekahau will 
use your MAC address to uniquely identify 
your PocketPC when you are in the EECS 
building.  To find your MAC address, follow 
these steps in order: 

o Click the Start button  
o Select Settings from the Start menu 
o Click the Connections tab 
o Double-click on the “Dell WLAN Utility” 

icon 
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o Click on the Advanced menu 
o Click on Network Troubleshooting 
o Click on the Advanced menu 

Your MAC address will be the first number 
listed on the screen. 

2. Connect your PocketPC to a computer to 
synchronize it (ActiveSync must already be 
installed using the instructions in section 2.2). 

3. Download the latest Ekahau client for the 
PocketPC found at 
http://www.ekahau.com/products/client/.  

4. Execute the Client32-install-wince.exe 
that you just downloaded. To install on 
additional devices, you can use ActiveSync by 
selecting Tools|Add/Remove Programs. Follow 
the instructions on your computer and 
PocketPC screens.  

5. Download a newer copy of the device driver 
from the Wlan development page at 
<http://www.eecs.umich.edu/~wherefid/ekahau
/Wlan.dev>. Copy this file onto your 
PocketPC, into the directory My 
Device\Program Files\Ekahau\Client. 
Ekahau will need to be shut down for this to 
work (if you're following these instructions, it's 
not running yet).  

6. Make sure your wireless internet has been 
enabled (a flashing green light on the antenna 
on the upper-right indicates that wireless is 
enabled; you may have to use the button on the 
lower-right of the device to turn it on) and that 
you have followed the authentication 
instructions detailed in section 2.1.  

7. Now start up the Ekahau client. You'll find it at 
the top of the Programs group. When it starts 
up, a little "blue bubble" (the Ekahau logo) will 
appear in the lower-right corner of your 
PocketPC display.  

8. Click on the Ekahau logo and follow the 
instructions below the set things up:  

o Select the Status tab, and press "Start 
Ekahau Client"  

o Select the Settings tab, and check "Start 
Ekahau Client automatically"  
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o Select the Engines tab  
 Uncheck "Accept by default"  
 Click "Add..." under Engines 

with saved settings. Under 
Engine details, enter:  

Name: RFIDsrv 
IP address: 141.213.10.73 
IP port: 8545 
Accept Data 
Requests: 

√ [Checked] 

 Press OK (upper-right corner)  
o Now press Apply  

9. Confirm that your device is now visible to 
Ekahau by browsing to the QDRLP stream at 
<http://rfidsrv.eecs.umich.edu/>.  Your device 
should be identified by the MAC address that 
you wrote down.  Look for a line like this: 

ISEE Ekahau.<your_mac_address> FROM 
<zone> COORDINATES <x,y> RELCOORD 
<x,y> AT # CONFIDENCE # 

If your device is not visible in the stream, try 
resetting the PocketPC with the button on the 
back. Don't forget to re-connect to the Internet 
when it comes back on. If all else fails, see the 
wherefid troubleshooting guide at 
<http://www.eecs.umich.edu/~wherefid/ekahau
/ekahau-ppc-trouble.html>.  

NOTE:  These instructions have been modified 
from the Ekahau installation instructions 
provided by the wherefid project.  Team Tour 
is not responsible for their accuracy and the 
instructions are subject to change at any time.  
Ekahau is an experimental system.  As such, it 
is prone to periodic crashes.  If the application 
is not responding, Ekahau is rebooting.  Exit 
the application, wait five minutes, and try 
again.   
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2.3 Installation of Tour Guide 
Application 
 
To install and run the tour guide application on your 
PocketPC: 
 

1. Connect the PocketPC to the computer to start 
an ActiveSync session.  The typical method is 
using the USB wire that came with the device. 
Make sure both the computer and the 
PocketPC are turned on, and then attach the 
appropriate end of the cable to the bottom of 
the PocketPC, and the other end to one of the 
computer’s USB ports. 

2. Insert the installation CD into the PC’s drive.  
Browse to Start|My Computer and locate the 
file called “PDA-Tour_PPC2.ARMV4.CAB” 
on your CD drive.  Copy the file to your 
Mobile Device (also accessible from My 
Computer).  Navigate to where you stored the 
CAB file and tap the file. 

3. The program will take a moment to install. Use 
the progress bar displayed on the screen to 
gauge the time remaining until the installation 
is complete. 

4. The PocketPC may display a warning about 
not appearing properly in this version of 
Windows Mobile.  You can safely ignore this 
warning.  Tap OK. 

5. Make sure you are authenticated (see section 
2.4 below if you are not familiar with CAEN 
authentication) on the CAEN Wireless network 
and that the Ekahau client is running. 

6. Browse to Start|Programs and click PDA-
TOUR. 

7. Start touring! 
 

2.4 Authentication 
 
To authenticate while inside the EECS building: 
 

1. Open a web browser.  You will automatically 
be redirected to the CAEN Wireless login 
page. If nothing loads, make sure your wireless 
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Ethernet card is running by following the steps 
in section 2.5 below. If a page loads, but it is 
not the wireless authentication page, try to 
access a webpage such as 
<http://www.umich.edu/ >.  

2. Type your U-M uniqname and password in the 
appropriate fields. 

3. Click the “login” button.  
4. You are now authenticated.  Close the browser 

window. 
   

2.5 Enabling a Wireless Connection on 
a Dell Axim 
 
To enable wireless on a Dell Axim PocketPC: 
 

1. When running, the Dell Axim’s built-in 
wireless device causes a blinking green light to 
appear at the top of the PocketPC. 

2. If there is a green light flashing on the top of 
the PocketPC but a web browser is unable to 
connect to a webpage, you may not be in range 
of a wireless access point. Try moving to a 
different spot (the atrium or the air bridges are 
good spots to try in the EECS building). 

3. If there is no green light, wireless has been 
disabled. To enable wireless, press the button 
located near the bottom-right corner of your 
PocketPC.  You should see a message 
indicating that wireless is being enabled, and 
can monitor the progress using the blue status 
bar displayed below the message. 

4. If wireless is now enabled, but you cannot 
access the authentication page, try the 
instructions listed under step 2. 

5. If you are still having problems, you may need 
to consult the CAEN helpdesk located on the 
second floor of the Duderstadt center. 

 

3 Using the Application 
 
When you launch the application, you will be directed 
to the Main Menu.  You should specify what kind of 
tour to take before starting a tour: 
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Architecture vs. Computer History Tour:  By default, 
the Architecture tour is selected.  The type of 
information selected on the main menu will be 
displayed first when you walk into a new zone. 
 
Guided Tour vs. Free Walk Mode:  In Guided Tour 
mode, you will follow a predefined tour path that 
begins at your current location. In Free Walk mode, 
you are free to move anywhere in the building.  Any 
information pertaining to the surrounding area will be 
made available on the PocketPC display automatically 
when you enter a new zone.  Detailed information 
about Guided Tour and Free Walk modes is available 
in the sections below.  After selecting the desired 
options, you are free to proceed on the tour.   
 
“Current Network” and “Current Mode” can be altered 
using settings from the Options menu as described in 
section 3.3.2. 

3.1  Free Walk Mode  
 
When the application is in Free Walk mode, your 
position is indicated at all times on the Map as a green 
beacon and is updated roughly once per second if the 
application is using Ekahau.  You are free to move 
about the building and tour whichever locations 
interest you the most.  When you move into a new 
area, new tabs pop up near the bottom of the 
application window, allowing you to access all of the 
information pertaining to the area.  For example, 
imagine that the EECS atrium contained both 
computer history and architectural information.  The 
application would display tabs corresponding to these 
two types of information when you entered the area.  
If you moved from the atrium into 1311 EECS (which 
contains only computer history information), the 
architecture tab would disappear, leaving the computer 
history tab with updated information relevant to 1311 
EECS.   

3.2 Guided Tour Mode 
 
You can also switch to Guided Tour mode by selecting 
it from the Main Menu.  In this mode, the tour will 
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follow a pre-defined path through the building.  As in 
Free Walk mode, your position is indicated by a green 
beacon on the Map.   
 
To start a Guided Tour, you must be at a tour stop.  If 
you attempt to start a Guided Tour when you are not at 
a tour stop location, a message is displayed indicating 
that you must move to a tour stop location before 
starting a Guided Tour.  A default tour stop location 
will now be displayed on the map as a red beacon—if 
you move to this location and attempt to start a Guided 
Tour again, the tour will commence. 
 
When a Guided Tour is active, there are always two 
beacons displayed on the map: your green beacon and 
a red beacon indicating the next stop on the tour.  
When you move to the next stop in the series, the 
beacon positions are updated on the map.  You can 
zoom in and out on the map using the button below the 
display, allowing access to an overview of the whole 
floor plan.   
 

3.3 File, Help, and About 
 
You will notice four menus near the bottom of your 
PocketPC display: File, Options, About, and Help. 

3.3.1 File 
 
The File menu only contains the Exit option.  Tapping 
Exit will close the tour application.   
 

3.3.2  Options 
 
Using the Options menu, you can switch between 
Simulation and Network mode, and turn Auto Follow 
on and off.  In Simulation mode, position data is read 
from a file called "log.txt" stored in the application's 
root directory.  In Network mode, position data is read 
in real-time from the Ekahau location sensing system.  
If you turn Auto Follow on, the Map window will 
center on your position as you move around.   
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3.3.3  About 
 
Clicking on the About menu item will provide you 
with information about the authors of the application 

3.3.4 Help 
 
Clicking on the Help menu will bring up help within 
the application. . 

3.4 Tabbed Browsing 
 
A number of tabs are available directly above the File, 
Help, and About menus: 
 
Main Tab:  Returns you to the Main Menu. 
Map:  Provides a display of your position relative to 
the floor plan of the EECS building. 
Image:  Contains an image associated with a zone (if 
one exists).  
 
The Main, Map, and Image tabs will always exist 
while the application is running.  Additional tabs will 
appear dynamically depending on the tour information 
associated with your current position.   

3.4.1 Map Tab 
 
The Map tab provides a display of your position 
relative to the floor plan of the EECS building.  Your 
position is indicated on the map by a green beacon.  
The scrollbars on the edges of the map display can be 
used to examine different portions of the map; the map 
will automatically focus on your location when you 
move into a new area if Auto Follow is turned on. 

3.4.2 Image Tab 
 
The Image tab contains an image associated with your 
current area (if one exists).  This image is always 
stored in .bmp format and should be less than 500 KB 
in size to ensure the program runs smoothly.   
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3.4.3  Tour Type Tabs 
 
Tabs that appear dynamically while running the 
application are Tour Type tabs.  All areas included in a 
tour contain computer history information, appearing 
on the “History” tab, and architecture information, 
appearing on the “Arch” tab. 

4 Adding Information 
 
To make adding location information simple, none of 
the tour information is stored inside the program, but 
is instead read from text files found in a subdirectory 
of the program.  The section below describes the 
purpose of each directory within the application, and 
the diagram to the right describes the hierarchy on 
disk: 
 
Root: The application’s root directory 
text: Contains all the text that will be contained inside 
the application, including init.txt and help.txt.  If you 
want to run the program in Simulation Mode, a file 
called log.txt should exist in the text directory as well.  
This file should contain a log of Ekahau’s operation to 
be parsed for simulation data.  
tourInfo: Contains the information that will be 
displayed for each tour type inside of a zone 
zones: Contains the files that describe each zone (these 
files include information about the zone name, 
associated image file, number of tour types, names of 
tour types, files associated with types, and the next 
zone on a Guided Tour for each type)  
images: Contains a map image  
for each floor in a building (stored as a 24-bit  
bitmap file) and all images associated with a zone 
 
Certain rules will apply to text files associated with the 
application: 
 

• A pound symbol (#) at the beginning of a line 
represents a comment.  Any line beginning 
with # is ignored by the parser. 

• All filenames are case-sensitive. 
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• Descriptions of tour types are placed in the 
tourInfo folder and must have file names that 
correspond to the name given in the zone file 
(zone files are stored in the zones directory).  
For example, if zoneEECS1311.txt specifies 
“eecs_1311_history.txt” as the file containing 
relevant historical information for 1311 EECS, 
then the tourInfo directory must contain a file 
called eecs_1311_history.txt.   

 

4.1  init.txt 
 
The init.txt file contains a short description of the zone 
file format and one integer attribute that represents the 
total number of zones.  The format of the file is as 
follows: 
 
# 
# short description of zone file format 
# 
numZones = … 
zoneFile = zoneA.txt 
zoneFile = zoneB.txt 
. 
. 
. 
 
The name of each zone file contained in the zones 
folder must be specified individually in init.txt using a 
“zoneFile =” identifier.  
 

4.2  Zone Files 
 
The following attributes are defined in a zone file (and 
must be represented in a specific syntax and order): 
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NOTE: Attributes 6-8 must be repeated for the number 
of tour types specified by attribute 3; if numTypes = 3 
then there would be 9 attributes.  Each zone file must 
contain attributes 1-8. 
 
For each tour type specified by the typeName field in a 
zone file, a .txt file must be included in the tourInfo 
folder of the project root.  This file can contain any 
text to describe the surrounding area of a zone.  It will 
automatically be read into the application at run time 
and will be displayed when the corresponding zone is 
entered.    
 

4.3 Associating an Image with a Zone 
 
Images can also be associated with a particular area in 
the building.  To associate an image with a zone, copy 
the image into the images directory on your PDA and 
update the corresponding zone file’s imageFile field 
with the image’s filename.  You can access any image 
associated with an area using the Image tab while 
standing in the area.  Images are automatically 
stretched or compressed to fit within the display area 
and must be in .bmp format.   

Attribute [#] Sample Syntax 
Zone name [1] zoneName =  ZoneA 

X-coordinate of the zone 
on the floor plan [2] 

zoneX = 1331 
(specified in pixels) 

Y-coordinate of the zone 
on the floor plan [3] 

zoneY = 506 
(specified in pixels) 

Image file corresponding 
to the zone [4] 

imageFile = image.bmp 

Number of tour types in 
the zone [5] 

numTypes = 2  
( less than or equal to 5) 

Name of tour type [6] typeName = History 
(this name will appear on the 
corresponding Tour Type tab 
during run time) 

Information file name for 
specific type [7] 

infoFile = 
zone1History.txt 

Zone name for the next 
tour stop on a guided 
tour [8] 

nextZone = 
eecs.floor2.2420 
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